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Dell EMC® ltemPoint™ for Microsoft SharePoint Serveris a software application that has been
distributed by Dell EMC. Use of the software is governed by the terms and conditions of the end
user license agreement contained within the software.

This manual should not be construed as any representation or warranty with respect to the
software named herein. Occasionally, changes or variations exist in the software that are not
reflected in the manual.

Generally, if such changes or variations are known to exist and affect the product significantly, a
release note or Read Me file will accompany the User Guide, or will be available on the Dell
EMC® ltemPoint™ website. In that event, please read the release notes or Read Me file before
using the product.

Dell EMC® ItemPoint™ for Microsoft SharePoint Serveris a frademark orregistered trademarks of
Dell EMC in the United States and/or other countries. All other brand and product names are
trademarks of their respective owners.

Copyright © 2018 Kroll Ontrack, LLC. All rights reserved.

Copyright 1991-2018 dtSearch Corp. Allrightsreserved.

The software is based in part on the work of the Independent JPEG Group.
DVN: 8.4.0.2

No part of this publication may be reproduced, transmitted, transcribed, stored in aretrieval
system, or translated into alanguage or computer language, in any form by any means,
electronic, mechanical, optical, chemical, manual or otherwise, without the express written
consent of Dell EMC.

Permission is hereby granted, free of charge, to any person or organization obtaining a copy of
the software and accompanying documentation covered by this license (the "Software") to use,
reproduce, display, distribute, execute, and fransmit the Software, and to prepare derivative
works of the Software, and to permit third-parties to whom the Software is furnished to do so, all
subject to the following:

The copyright notices in the Software and this entire statement, including the above license
grant, thisrestriction and the following disclaimer, must be included in all copies of the Software,
in whole orin part, and all derivative works of the Software, unless such copies or derivative works
are solely in the form of machine-executable object code generated by a source language
processor.



THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT
HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER
LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

For contact information for our worldwide locations, see
https://www.dellemc.com/en-us/contact-us.htm

Dell EMC Technical Support

1-800-SVC-4EMC
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Introduction
Overview

Welcome to Dell EMC® [temPoint™ for Microsoft SharePoint Server, a powerful, yet easy-to-use
application for searching, recovering, restoring, and managing data at a granularlevel in
Microsoft® Office SharePoint® Server environments.

With Dell EMC ItemPoint for Microsoft SharePoint Server, you can perform source and target
functions on Microsoft Office SharePoint Server data. It also provides arobust search function on
source items to quickly and easily find, recover, and restore content — such as documents, lists,
libraries, and folders — or entire Microsoft Office SharePoint Serversites.

Dell EMC ltemPoint for Microsoft SharePoint Server works with your existing database so can
restore content from MDF files, NDF files, and LDF files directly to your Microsoft Office SharePoint
Server target, or to a different server.

Five Major Reasons for Using Dell EMC ItemPoint
for Microsoft SharePoint Server

There are five primary ways you can benefit from using Dell EMC ltemPoint for Microsoft
SharePoint Server:

1. Minimizes the time to restore an individual document, item, list, folder, site, or library.

Dell EMC ltemPoint for Microsoft SharePoint Server can slash restore time, making it possible to
granularly restore items from a previous full backup. Items from database backup can be
restored individually, giving you restore flexibility and eliminating the need to perform to a full site
restoration in order to find the items you need.

2. Eliminates same site restore constraint.

By eliminating same site restore constraint, Dell EMC ItemPoint for Microsoft SharePoint Server
gives you the flexibility to restore to origination or alternate locations. With Dell EMC ltemPoint for
Microsoft SharePoint Server, you canrestore directly info your production Microsoft Office
SharePoint Server or afile system.

3. Minimizes the time to locate all matching specific criteria.

Dell EMC ltemPoint for Microsoft SharePoint Serverincludes an Advanced Find feature that can
search across all content databases in an archived Microsoft Office SharePoint Server file, rather
than bringing an old backup back online for analysis. You can search by a variety of criteria,
including keywords, subject, date, specific users, and file and attachment data.

4. Maintains data integrity of the Microsoft Office SharePoint Server source.

Dell EMC ltemPoint for Microsoft SharePoint Server does not change the contents or metadata
of the source content database, and maintains data integrity of the source by performing read-



only operation.

5. Minimizes the costs involved in restoring lost items.

Dell EMC ltemPoint for Microsoft SharePoint Server eliminates the need to have an expensive
restoration server available, as well as the cost associated with the extra steps required to
separately import sites back into Microsoft Office SharePoint Server to find items needed. Also,
since it canread your existing content database backups, there is no need to purchase
proprietary software for creating the backups. Your backup process canremain the way it is
today.

Getting Help

Dell EMC provides you with the following ways to get help with Dell EMC ItemPoint for Microsoft
SharePoint Server:
m Online Help

m Technical Support

Online Help
Online Help includes all of the information in the user guide. You can quickly access this
information using the following online Help tabs:

m Contents: Displays a hierarchical view, similar to the Contents of the user guide.

m Index: Provides a list of key words to locate specific topics.

m Search: Offers a full-search of the Help file.

To start online Help

m Do one of the following:

« Onthe Help menu, click Contents

. Click 2 on the toolbar.

o Pressthe F1key.

Context Sensitive Help

You can click the Help button that appears on many of the dialog boxes when using Dell EMC
[femPoint for Microsoft SharePoint Server to open the online Help topic related to the current
task.

Tooltip

When you position the pointer over a tool or control and pause, a message box appears with a
definition of your selected item.



Technical Support

If you have questions or problems not answered in the user guide or the online Help (F1), contact
our Technical Support group. When reporting anissue, please include any information that
might help us diagnose the problem. The following details are often the most helpful:

m The version of Dell EMC ltemPoint for Microsoft SharePoint Server you are using (on the
Help menu, select About).

m The versions of Windows operating systems that you are running.

m The version of SQL Server that contained the source database file.

= The version of Microsoft Office SharePoint Server for the source data.

m The version of Microsoft Office SharePoint Server for the target.

m The circumstances and sequence of steps that led to the problem.

m The text of the error messages (if any appeared), and the contents of the Details window.

m Alist of other Windows-based programs that you were running when the error occurred.

For more information, please see "Contact Information" at the beginning of this user guide.



Chapter 1: Looking at the Interface

Overview

This section describes the main window of Dell EMC ltemPoint for Microsoft SharePoint Server and
details the functions of the:

= Menu bar

m Toolbar

m Source and Target panes

m Source Item and Target ltem lists

It also explains how to:

m Change the appearance of the main window
m View the properties of a content database
m View the targetin a browser

m Use the Preferences dialog box

Main Window

The main window of Dell EMC ltemPoint for Microsoft SharePoint Server is where you do most of
your work. The main window is divided into four panes by two split bars: the two Source panes
above the two Target panes.

The Source panes display the source MDF, NDF, and LDFfile(s). The left Source pane contains the
confent database tree view. When you select anitem in this pane, its contents appearin the
right Source pane.

The Target panes act as a container for the restored items on the target server. The left Target
pane contains the Microsoft Office SharePoint Server nodes and contents copied, dragged, or
added through the Data Wizard. The right Target pane displays the list of the contents of the
item selectedin the tree view on the left Target pane.

Any functions that can be performed on a source dataitem or target items can be accessed
through the menu bar, the toolbar, or the right-click context menus.
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Figure 1-1: The main window with its four panes.

Key items on the Dell EMC ItemPoint for Microsoft SharePoint Server main window:

—_

Menu Bar

Toolbar

Source Location
Source Pane
Source Message List
Target Location
Target Pane

Target Message List

W O N O AW Dd

Status Bar

Menu Bar
File Edit Wew Tools Help

Figure 1-2: The menu barin the main window

The menu bar contains all of the commands for Dell EMC ItemPoint for Microsoft SharePoint
Server. The menu commands, submenu commands, and resulting dialog boxes are discussed
fully in the sections that focus on those specific commands.

Toolbar

Figure 1-3: The toolbarin the main window

The buttons on the toolbar perform the following functions:



Icon Function

ﬁ Open Source opens the Source Path Selection page of the Data Wizard, where you can add .mdf,
.ndf., and .Idf files.

T | Open Target opens the Target Server Selection page of the Data Wizard, where you can enter the
target Microsoft Office SharePoint Server name, configuration database, and authentication.

E@ Copy copies onto the clipboard the selected item(s) in the source list or list and folders from the tree
view.

5 Paste inserts the items from the clipboard into the selected list or folder in the Target pane.

local or network drive destination.

m Export displays the Export Options page of the Export Wizard, which lets you export an item to a

Find displays the Find in Sources dialog box, which lets you specify the desired search criteria for
finding items in the Source pane.

@ View Help displays Dell EMC ItemPoint for Microsoft SharePoint Server Online Help, which
includes all of the information in this user guide and more. Online Help lets you quickly access this
information by using a Contents, Search, or Index tab.

Shortcut Menu

You can access many of the same commands available on the menu bar and toolbar by right-
clicking the mouse to open ashortcut menu. The contents of the shortcut menu depend on
whether you right-click in the Source or Target pane. This manual aims to explain how to use
commands on the menu bar and toolbar, and doesn't always specify when you can use the
shortcut menu. Once you become familiar with Dell EMC ltemPoint for Microsoft SharePoint
Server, the commands available to you on the shortcut menu should become apparent.

Source Panes

The Source pane displays the content database files that you selectedin the Source Path
Selection page of the Data Wizard. The source tree can display one or more sources. It displays
the source as a tree view and mimics the hierarchy of the database.

| Source: C:\Documents and Settings\[

=[5 Sources
=iy Source 1-WSS_Contert_6d5hc
= D efaul site
i App Copy Ste
=% Meeting workspace
Agenda
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agenda again
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another Slide Library
1= Attendees
|7 calendar
< | )

=
FobBBE




Figure 1-4: Source pane

For more information on using the Source panes, see "Data Wizard: Source Path Selection Page™
onpage 19.

The Source Item list displays the source itemsin a list with columns depending on the type of
source list. The columns can include leaf name; attachments, if any; title; content type; Ul
Version; modified and created on dates; created by; and modified by.

U] Leaf Name Title Cortert Type UlVersion Modified On Created On Created By Modified By
1_.000 Link: 1.0 10/23/2007 1:5... 1042372007 1:5... Malen fa Baidll B % Pl

2_000 Link 1.0 10/23/2007 1:5... 10/23/2007 1.5, Bl Pallaid il %l

3_.000 Link: 1.0 10/23/2007 1:5... 10/23/2007 1:5... [y e o | of
< *

Figure 1-5: Source Item List

You can open a source data list item using the native application with which it was created by
right-clicking on the item and selecting Open File in the context menu. If the native application
for the item is not available on your computer, a dialog box appears where you can select the
application to view the item data. If you want to view the metadata of anitem that can be
opened with the native application, right-click and select Open Item.

Source Item List Context Menu

Source list items have several functions available through a context menu. You canright-click
on anitem or multiple items to display a context menu with the following options available:

= Open ltem: Displays the metadata of anitem in a new dialog box or open the native
application.

m Open File: Open File is available if the item has a content stream. Only one item can be
selected at atime.

m Copy: Copies the selected item oritems to the clipboard.
m Select All: Selects all of the itemsin the list.

m Export: Opens the Export Wizard where you can save the selecteditem to a selected
location.
= Save Altachments: Opens the Save Attachment dialog box where you can save the

attachments of the selecteditem to aselected location.

m Previous Versions: Opens the Previous Versions dialog box where you can view the
previous versions of the item and copy them to a selected location or to the Target pane.



Some context menu items are unavailable when multiple items are selected; for example,
"Openltem,""Open File,""Save Attachments," and "Previous Version" functions.

For more information on all of these functions, see "Using Dell EMC ItemPoint for Microsoft
SharePoint Server' on page 18.

Target Panes

Dell EMC ltemPoint for Microsoft SharePoint Server can connect to target Microsoft Office
SharePoint Servers. One or more targets can be opened at atime. The target data appearsin
the Target pane, which mimics the hierarchy of the database.

|Target:
=[5 Targets
= ,_E; Target 1 - http:/target_server local
= Administrator
=] Documents
=] Form Templates
=l Images
x| Cther Blogs
=] Personal Documents
=1 Shared Documents
| Shared Pictures
Test Custom List
= Test
=] Form Templates
< >

Figure 1-6: Target pane

The Target Item list displays the target itemsin a list with columns depending on the type of
target list. The columns caninclude leaf name; attachments, if any; title; content type; Ul
Version; modified and created on dates; created by; and modified by.

il Leaf Name Title Content Type UlVersion Modified On Created On Created By Modified
cool couch jpa Bob's Cortent ... 20 1/17/2008 4:14... 1/17/2008 4:14... System Accourt  System Ao

Figure 1-7: Target Item List

You can open a target data list entry using the native application with which it was created by
right-clicking on the item and selecting Open File in the context menu. If the native application
for the item is not available on your computer, a window appears where you can select the
application to view the item data. If you want to view the metadata of anitem that can be
opened with the native application, right-click and select Open Item. For more information, see
"Opening ltems" on page 28.



< Open Item - How To Use This Wiki Site.aspx

File
Path: SharePoirt_CorfigContentDb'\Wiki Pages\How To Use This Wiki Site aspx
Property Name Value &
_ModerationComments
_SharedFilelndex
_SourceUrl
Attachments False
Content Type Wiki Page
Created By System Account
Created On 6/3/2008 2:36:03 PM
Created x0020 By
File x0020 Type aspx
HTML_ x0020 File x0020 Type
Leaf Name How To Use This Wiki Site_aspx
Modified By System Account
Modified On 6/3/2008 2:36:03 PM
Modified_x0020_By SHAREPOINT\system
UlVersion 1.0
WikiField How to use this wiki site 3

Figure 1-8: Open Item metadata

Note: Not all the data about an item appearsin the list.

Icons in the Source and Target Panes

Inthe Source and Target panes, the root nodes, sites, lists, and folders have individualized icons.
Any list type without an assigned icon uses a default icon

Note: Not all lists for a site are shown in the list. If certain lists contain system information, they
may not be shown.
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Figure 1-9: Sample icons with descriptions below

Icon Description

21 | Sources contains one or more source data stores. You can select the sources root node as your
search source.

21 |Targets contains the target Microsoft Office SharePoint Server databases for connection as a
target.

LEi Source Root Node contains the .mdf, .ndf, and .Idf files. Click the plus sign (+) next to a node to
expand its contents.

uEi Target Root Node contains the target server. Click the plus sign (+) next to a node to expand its
contents.

& |site contains the site/site collection nodes lists. Click the plus sign (+) next to a node to expand its
contents.
Default icon for List objects, custom lists, and Datasheet
Document Library, Form Library, Wiki Page Library are Web Parts that organize documents by
department, project, or by topic.

=1 |Folders can be created within Web Parts to organize documents or lists.
Discussion Board can contain Web discussion notes between users of the site.

£z | Agenda can contain information that meeting attendees need to have access to in advance of a
meeting.

A |calendaris a view of the events list after recurring events have been added.

=" | Text Box can be created within a Web Part to just contain text.

il:! |Surveys can contain various forms of surveys: online surveys, email-based surveys, and database-
driven surveys.

2= |Contacts, Attendees are lists that contain contacts for the users of the site including phone

| numbers, email addresses, and other information.
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Icon Description

| [Picture Library, Report Library are Web Parts similar to Document Libraries which store
documents and allow users to attach metadata to the documents.

& |Data Connection Libraries are Web Parts similar to Document Libraries which store documents
and allow users to attach metadata to the documents.

x| Slide Libraries are Web Parts similar to Document Libraries which store documents and allow
users to attach metadata to the documents.

i#=| |Translation Library, Languages, and Translators are the list of languages to assign to translation
tasks and any translators specified for each language.

=il |Announcements is a Web Part in SharePoint and contains any announcements entered by a Site
Administrator.

<« |Links is a Lists Web Part that provides easy access to websites.

=1 |Tasks s a Lists Web Part used for managing tasks within a project.

Project Tasks, Issue Tracking are used to track issues based on different categories added by the
Site Administrator.

il |Decisions is alist created from a template within a Meeting Site in SharePoint.

e |Things to Bring contains lists in the Lists Web Part.

= |Datasheetis a view within a library or list that requires Microsoft Excel to open.

[=] |KPI List contains Key Performance Indicator lists in the Lists Web Part.
(This is appears as Status List in Microsoft Office SharePoint 2010).

iz |Circulations contains lists that track to track the flow of documents in a Group Work list (Microsoft
Office SharePoint 2010 only).

ﬁj IME Dictionary List contains data used in a list as a Microsoft Input Method Editor (IME) dictionary

L (Microsoft Office SharePoint 2010 only). P

Changing the Appearance of Main Window

You can change the view in the Dell EMC ItemPoint for Microsoft SharePoint Server window by
hiding the toolbar or status bar, adjusting split bars; sorting lists; and refreshing the screen.

Viewing or Hiding the Toolbar and Status Bar

The toolbar and status bar appear by default in the main window, but you can easily hide them.

To hide the toolbar or status bar

= Onthe View menu, select Toolbar or Status Bar. The check mark no longer appears next

to the name of the toolbar or status bar.

1



To view the toolbar or status bar

m Onthe View menu, select Toolbar or Status Bar. The check mark appears next to the
name of the toolbar or status bar.

Resizing Panes Separated by a Split Bar

You can use asplit bar (the horizontal or vertical double line that separates two panes) to
increase the area within one pane while simultaneously decreasing the area within the
adjacent pane.

To resize panes separated by a split bar

1. Position the pointer over a split bar between the two panes on either the vertical or

horizontal split bar.

| Source:
=l 57 Sources - ] Leaf Name Title Contert Type UlVersion Modffied On Created On
= iis Source 1-WSS_Content_6dfbc test! -afterad... testl-a.. Picture 10 1/23/2008 11:0... 1/23/2008 11:0.]
=88 Defautt site =
% App Copy Ste
= :'5 Meeting workspace
ma| Agenda <+ >
ma| Agenda - Meeting workspac
#a| agenda again
wa| Agenda List
[0 ancther Slide Library A
3= Attendess .
] calendar v I >
< | > 1 of 1items selected
|Target:
= 57 Targets - 1] Leaf Name Title Contert Type UNersion Modified On Created On
=i Target 1-hitp: target_server local Sample aspx Document L 5/14/2008 8:41... 5/14/2008 8:41..
=¥ Administrator
=1 Documents test.doc test Document 10 5/14/2008 8:24... 5/14/2008 8:24.. |
=] Form Templates B
= Images
| Other Blogs
=1| Personal Documents
=]l Shared Documents
lig:| Shared Pictures
Test Custom List
- Test
=] Form Templates hd hd >
< | > 1 of 2 items selected

Figure 1-10: Arrange Columns context menu

2. When the pointer becomes a double-headed arrow, drag it fo resize the pane.

Arranging Columns in the Items List

You can arrange the columnsin the Source and Target Items list by dragging the column
headers. You can add orremove columns by right-clicking on the column header to view the
Arrange Columns context menu.

12



Content Type
Wiki Page
Wiki Page
Wiki Page
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Figure 1-11: Arrange Columns context menu

Selecting Arrange Columns opens the Arrange Columns dialog box.

Arrange Colurmng

Available:

Drezcription
Duration
EventCanceled
EwventType

A0 ayE vent
File_x0020_Type
[Recurrence
MasterSeriesltemlD
RecurenceData
TimeZone

UiD

LRL
WiarkspaceLink
HMLTZohe

Select the columng to display in the item list.

Include >
Include 41l > >

¢4 Exclude Al

Current:

Attachments
Leaf Mame
Title

Content Type
Ulverzion
todified On
Created On
Created By
todified By
EndDate
EwentD ate
Location
RecurrencelD
Wiorkspace
Wiorkzpace

(1]8

] [ Cancel

Figure 1-12: Arrange Columns dialog box

To arrange columns horizontally

1. Select one ormore itemsin the Available list and click Include>. The item(s) appear at

the bottom of the Current list.

o A~ W DN

Click OK.

To set the lists to the default setting, click Reset.

To include all of the Available list items in the Current list, click Include All>>.

To exclude all of the Current list items in the Available list, click <<Exclude All.
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Note: At least one column must remain in the Current list to exit from the Arrange
Columns window.

Note: You can display up to eight lookup columns on the target.

To arrange columns vertically

1. To arrange the orderin the Current list, select one item at a time and click Move Up or
Move Down. The list appearsin this order from left to right in the Source or Target list view.

2. Toset the lists to the default setting, click Reset.

3. Click OK.

Sorting Iltems in the Iltems List

You cansort itemsin the source and target lists based on any column.

To sort a list

1. Click acolumn heading to sort the items based on that heading. For most headings, an
arrow appears indicating the sort direction. An up arrow indicates that the items appear
in ascending (A-Z) order. A down arrow indicates that the items appear in descending (Z-
A) order.

2. Toreverse the order of the items based on that column heading, click the column
heading again. Nofice the arrow reverses directions.

An example of sorling items

s Ifyou click the attachment M column heading, items are sorted in descending order

based on this heading, even though no arrow appears. This means that items with
attachments appear at the bottom of the list, while items with no attfachments appear at

the top of the list. If you click the attachment M column heading again, the order s

reversed.

Note: The view settings (sort order and column width) for a folder or list are saved until
you close the data store.

Refreshing the Screen

You may want to refresh the screen occasionally when you are connected to alive target
server, as the information on the server may change while you are connected.
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To refresh the screen

m Do one of the following:

« Onthe View menu, select Refresh.

o Pressthe F5key.

Viewing the Properties of a Content Database

Dell EMC ltemPoint for Microsoft SharePoint Server makes it easy to view the properties of a

content database file.

To view the properties

1. Inthe Source pane, right-click a content database file.

2. Onthe shortcut menu, select Properties to view the MDF File Properties dialog box.

P

MOF File Properties

Database Information

Database Mame:
Database GUID:
SQL Version:
SharePairt Version:

Primary Database File:

Size of Database Files:

Size of RBS:

Total Database Size:
Log File Information

Mumber of Log Files:

Size of Log Files:

Conterts
MNumber of Sites:
MNumber of Lists:
Number of Folders:

Mumber of kems:

Mumber of Database Files:

WSS _Content
20b5dece-Ye2c-debo-abde-=013585e576
SQL 2008 R2

15.0.4569.1000

C:hData“SharePoirt 2013 Source Data® W55 _Conte ..

1
5325 MB (k5,836,672 bytes)
0 bytes

5325 MB (55,836,672 bytes)

1
12.06 MBE (12,648 448 bytes)

[ 2 el

Figure 1-13: MDF File Properties (without Remote Blob Store)



MDF File Properties =

Database Information

Databasze Mame: W55_Content_RBS_SQ12008R2_PCSP2013B
Database GUID: 12614538 7clf-4cBf-bad5-6d837d Hb 626
SQL Version: SQL 2008 R2
SharePoint Version: 15.0.4505.1002
Primary Database File: C:\Data“SharePoint2013 Source Data RBSAttachm. ..
MNumber of Database Files: 1
Size of Database Fles: 221 25 MB (231,957 440 bytes)
Size of RBS: 151.20 ME (158,548 885 bytes)
Total Database Size: 372 .45 MB (350,546,325 bytes)
Log File Information
Mumber of Log Files: 1
Size of Log Files: 16.44 ME (17,235,568 bytes)
Cortents
MNumber of Sites: 3
MNumber of Lists: 26
MNumber of Folders: 18
MNumber of kems: 93

Figure 1-14: MDF File Properties (with Remote Blob Store)

Setting Preferences

With the Preferences dialog box, you can set the defaults for how Dell EMC ltemPoint for
Microsoft SharePoint Server performs recurrent operations.

To change preference settings

1. Onthe Edit menu, select Preferences.

2. Select orclearthe check boxes, as desired.



F !

Preferences @

| Run Datawizard on startup

o | Shaw warning whet nio log files specified
o | Check for duplicates during copy

| Autormatically connect to ACTS

] ] | Cancel

Figure 1-15: The Preferences dialog box

Run Data Wizard on startup: When this optionis selected, the Data Wizard starts every time
you open Dell EMC ItemPoint for Microsoft SharePoint Server.

Show warning when no log files specified: When this optionis selected, Dell EMC
ltemPoint for Microsoft SharePoint Server warns you when opening a file if an .Idf file path
has not been specified.

Check for duplicates during copy: When this option is selected, two forms of duplicate
checking will occur depending on the type of item that is being copied. In either
method, if anitem is a duplicate and you choose to overwrite, the existing itemis
removed and the new item is added. For more information, see "Duplicate Checking" on
page 52.

Automatically connectto ACTS: When this optionis selected, Dell EMC ltemPoint for
Microsoft SharePoint Server will automatically attempt to connect to the Agent for
Content Transfer Service when you click Next on the Data Wizard: Target Server Selection
Page.
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Chapter 2: Using Dell EMC ItemPoint for
Microsoft SharePoint Server

Overview

You can open a source MDF file or NDF file and specify a target Microsoft Office SharePoint
Server using the Data Wizard. You can also open the source database and target server from the
main window, as well as open a source database with the command line.

Keyboard Shortcuts

The following tfable contains keyboard shortcuts for many of the common tasks performed when
using Dell EMC ItemPoint for Microsoft SharePoint Server.

Menu Bar Keyboard Shortcut

File Menu

Open Source Ctrl+S
Open Target Ctr+T
Open Item Ctr+0O
Close Store Ctri+L
Use Wizard Ctr+W
Exit Alt+F4
Edit Menu

Copy Ctri+C
Paste Ctrl+V
Select All Ctri+A
Launch in Browser Ctrl+B
View Menu

Refresh Screen F5
Tools Menu

Export Ctri+P
Find F3
Help Menu

L\/iew Help Contents F1 )
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Opening the Source Database and Target
Servers with the Data Wizard

The Data Wizard guides you through the loading of the MDF, NDF, and LDF files into Dell EMC
ltemPoint for Microsoft SharePoint Server and shows you how to specify the target server.

Opening the Data Wizard

The first time you start Dell EMC ItemPoint for Microsoft SharePoint Server, the Data Wizard opens
at the Source Path Selection page.

When working in the main window, you canreturn to the Data Wizard at any tfime.

To manually start the Data Wizard

m Onthe File menu, select Use Wizard.

Data Wizard: Source Path Selection Page

Use the Source Path Selection page of the Data Wizard to specify the source MDF, LDF, and NDF
file paths and the temporary file path.

Note:

m If you do not want fo open a source MDF, NDF, and LDF file at this time, click Skip.

m [f you do not want fo run the Data Wizard every time you start Dell EMC ltemPoint for
Microsoft SharePoint Server, clear the Show wizard on startup check box.

To specify a source file

1. Inthe Source Files group, do one of the following:

m Click Add and use the Open dialog box to find the source .mdf file, .ndf file, and .Idf
files.

m Open Windows Explorer and drag the source files from their location onto the
Source Files box.

Important: Verify that the log files and database files were created in the same backup.

Important: If your source content database contains an NDF file, it must be included with
the MDFfile.

Note: Multiple files can be added to the Source Files box and are listed in the order they
were added, however, only asingle content database can be opened.
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Note: If you want to remove files from the Source Files box, select the file and click
Remove.

2. Inthe Temporary File Path box, accept the default location for the .idx and .dat files or, if
the files require more hard drive space, specify a new location by clicking Browse {...).

Add...

Temporary File Path [*.id=, " dat]
C:ADocuments and SettingziLocal Settingz\Temp', - E

Figure 2-1: Temporary File Path selection

3. Click Next. The Target Server Selection page appears.

Data Wizard: Target Server Selection Page

Use the Target Server Selection page of the Data Wizard to enter the information to connect to
the server running Microsoft Office SharePoint Server you are using as the target for your restored
data. If you do not want to select a target at this fime, click Skip.

To specify a serverrunning Microsoft Office SharePoint Server as the target forrestored data

1. Inthe SharePoint Server Site URL box, do one of the following:

m Enter the URL of the server running Microsoft Office SharePoint Server you are using
asthe target.

m Use the drop-down arrow to select a previously used target.
2. Inthe Authentication Information group, select one of the following:

m Connect using the current Windows credentials fo use Windows credentials of the
currently logged-in user to access the web service.

m Connect as a different Windows user, then enter the Username, Password, and
Domain of that Windows user.

= Connect using Forms Authentication, then enter the form credentials Username
and Password.

3. Click Next.
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Data Wizard: Agent for Content Transfer Service (ACTS)
Selection page
Use the Agent for Content Transfer Service (ACTS) page of the Data Wizard to enter the

information to connect to the server running Microsoft Office SharePoint Server you are using as

the target for yourrestored data. If you do not want to select a target af this fime, click Skip.

To specify a server running Microsoft Office SharePoint Server as the target for restored data

1.

In the Agent for Content Transfer Service Port Number box, enter a valid port number to
use ACTS.

In the Authentication Information group, select one of the following:

m Connect using the current Windows credentials to use the credentials for Windows
user currently logged in.

m Connect as a different Windows user, then enter the Username, Password, and
Domain of that Windows user.

If a User Principal Name is required for Kerberos authentication, select User Principal
Name (UPN) required for Kerberos authentication to enable the UPN box and enter the
user name of the account running the ACTS on the server (example format:
user@domain.local).

Click Finish.

Remote Blob Store Configuration (FILESTREAM Provider)

When you attempt to open a source, Dell EMC ItemPoint for Microsoft SharePoint Server checks
if Remote Blob Store (RBS) is enabled and if FILESTREAM is in use. If both are true, the Remote

Blob Store Configuration dialog box appears, prompting you to select the RBS FILESTREAM files
(filestream.hdr).

To select the RBS FILESTREAM configuration files

1.

On the Remote Blob Store Configuration dialog box, click Add.
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Remote Blob Store Cenfiguration @éj

This source uses a Remote Blob Store. Please configure the provider before continuing.

Corfigure - Filestream

Flease select the RES filestream configuation files filestream hdr) for this database.
Files:

[ Fnsh | [ Skip | [ Cancel |

Figure 2-2: Remote Blob Store dialog box with FILESTREAM provider.

2. Use the Choose configuration file dialog box to select the RBS FILESTREAM files
(filestream.hdr) for this database.

3. If you are using multiple providers, click Next on the Remote Blob Store Configuration
dialog box and configure additional providers.

Note: You canremove afilestream.hdr from the Files box by clicking Remove.

4. Click Finish.

Remote Blob Store Configuration (Metalogix StoragePoint
Provider)

When you attempt to open a source, Dell EMC ItemPoint for Microsoft SharePoint Server checks
if Remote Blob Store (RBS) is enabled and if Metalogix StoragePoint isin use. If both are true, the

Remote Blob Store Configuration dialog box appears, prompting you to select the Metalogix
StoragePoint server URL.

Note about the licensing agent: The "Agent for Metalogix StoragePoint" must be enabled in
order to restore data from an RBS provider.

To configure the Metalogix StoragePoint server URL

1. Onthe Remote Blob Store Configuration dialog box, click Add.
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2. Inthe Metalogix StoragePoint server URL box, do one of the following:
m Enferthe URL of the server that is running Metalogix StoragePoint.

m Use the drop-down arrow to select a previously used target.
Remote Blob Store Configuration [ ? ﬁl

This source uses a Remote Blob Store. Please configure the provider before continuing.

Configure - Metalogix StoragePoint

Metalogix StoragePoint server URL:

() Connect using the cument Windows credentials

@ Connect as a different Windows user

Uzemame: -
Password:
Daomain: -

() Connect using Forms Authentication

Usemame:

Password:

| Frsh | [ skp | [ Cancel |

Figure 2-3: Remote Blob Store dialog box with Metalogix StoragePoint provider

3. Select one of the following:

m Connect using the current Windows credentials to use Windows credentials of the
currently logged-in user to access the URL.

m Connect as a different Windows user to enter different Windows credentials than
the currently logged-in user, then enter the Username, Password, and Domain of
that Windows user.

= Connect using Forms Authentication, then enter the form credentials Username
and Password.

4. Click Finish.

Remote Blob Store Configuration (StorSimple SharePoint
Database Optimizer)

When you attempt to open a source, Dell EMC ItemPoint for Microsoft SharePoint Server checks
if Remote Blob Store (RBS) is enabled and if StorSimple SharePoint Database Optimizerisin use.

If both are true, the Remote Blob Store Configuration dialog box appears.
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With the Remote Blob Store Configuration dialog box, you can verify the UNC path(s) that
references the root location(s) of the StorSimple SharePoint Database Optimizer RBS Blob store
data orsubstitute for another path(s) (as may be the case if the original blob store is no longer
available or has been significantly altered since the content database backup).

Note about the licensing agent: The "Agent for StorSimple SharePoint Database Optimizer' must
be enabledin order to restore data from an RBS provider.

To configure the StorSimple SharePoint Database Optimizer

1. Onthe Remote Blob Store Configuration dialog box, do one of the following:
m Review and accept the Original Path(s) used by the content database and
continue to open this source.
m [fyou want to update the Active Path for Blob Store Path 1 or Blob Store Path 2,
click its Browse button and use the Browse for Folder dialog box to select the
location of the StorSimple SharePoint Database Optimizer RBS Blob store data for

the database.

Remote Blob Store Configuration . &li_hj

This source uses a Remote Blob Store. Please configure the provider before continuing.

Corfigure - StorSimple SharePoirt Database Optimizer

Please review the paths below.

N
i Blob Store Path 1
l Criginal Path: “WPCSP2013cM\StorSimple_Share1
| Active Path: \\PCSP2013c\StorSmple_Share (-]
|
| Blob Store Path 2
I Criginal Path: “WPCSP2013c\StorSimple_Share2
| Active Path: \\PCSP2013c\StorSimple_Share2 (]
I
I
| EBnsh | [ sa | | Cancel |

Figure 2-4: Remote Blob Store dialog box with StorSimple SharePoint Database Optimizer
provider

2. Click Finish.
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Results of Data Wizard

When you complete the Data Wizard, the Source panes in the main window display a source
content database (which contains an MDF file, 1 or more LDF files, and 0 or more NDF files) and
the Target panes display a target server.

Important: If your source content database contains an NDF file, it must be included with the
MDF file.

|Source:
=[5 Sources ~ 1] Leaf Name Title Content Type UlVersion Modified On Created On
= iia Source 1-WSS_Content_6dSbe test]-fterad... test]-a... Picture 10 1/23/2008 11:0... 1/23/2008 11:0.
=8 Default ste =
% App Copy Stte
= $ Meeting workspace
w2 Agenda

72 Agenda - Meeting workspar
2| agenda again
w2 Agenda List
(5] another Slide Library
3= AMtendees
[T calendar s >

| 3| | 1of 1items selected

|~

Figure 2-5: Source panes with a source confent database

|Target:
=[5 Targets ~ 1] Leaf Name Title Cortert Type UlVersion Modified On Created On
=iy Target 1-htip:/farget_serverlocal Sample aspx Document 10 5/14/2008 8:41... 5/14/2008 8:41..]
= Administrator
=1 Documents test.doc test Document 10 5/14/2008 8:24... 5/14/2008 8:24. |
=] Form Templates B
=1l Images
«s| Other Blogs
=1| Personal Documents
=1| Shared Documents
lig:| Shared Pictures
Test Custom List
=0 Test
=] Form Templates v < >
< | > 1 of 2 items selected

Figure 2-6: Target panes with a target server

Opening the Source Database and Target
Servers from the Main Window

Instead of running the entire Data Wizard, you can access the Source Path Select page or the
Target Server Selection page from the main window.

Opening Source or Target Files

You can access the Source Path Select page to open the source databases or the Target
Server Selection page to open target servers from the main window. These two pages are
identical to those on the Data Wizard, with the Next button replaced with a Finish button.
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To open a source file

1. Do one of the following:

= On fthe File menu, select Open Source.
s Onthetoolbar, click the Open Source icon N .
= Press Ctrl+S

m Drag asingle MDFfile intfo the source tree pane of the main window.

2. Complete the Source Path Selection page.

3. Forinformation about how to complete the Source Path Selection page, see "Data

Wizard: Source Path Selection Page” on page 19.

4. Click Finish.

Depending on your configurations, you may need to complete the Remote Blob Store
Configuration dialog box. For more information, see "Remote Blob Store Configuration

(FILESTREAM Provider)" on page 21.
To open a target
1. Do one of the following:
= On fthe File menu, select Open Target.
s Onthe toolbar, click the Open Targeticon L .

= Press Cirl+T
2. Complete the Target Path Selection page.

Forinformation about how to complete the Target Path Selection page, see "Data
Wizard: Target Server Selection Page" on page 20.

3. Click Finish.

Opening the Source Database from the
Command Line

In addition to using the Data Wizard or main window, a third method to open the source
databasesis with the command line.

To open the source database with the command line

1. Openthe commandline.
2. Type the location of the Dell EMC ItemPoint installation files, followed by EMCIPSP.exe.

3. Append this with the temporary file path and/or the source file names as parameters.
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m Every source file name must be prefixed with the keyword -sourcefile and enclosed
within double quotes. The prefix and the file name must be separated with a space.

m The temporary file path must be prefixed with -t keyword and enclosed within
double quotes. The prefix and the temporary file path name must be separated
with a space.

m [fthe database uses RBS FILESTREAM, specify the location of the .hdr files prefixed
with -rbsfilestream and enclosed within double quotes. The prefix and the file path
name must be separated with a space.

m [fthe database uses StorSimple RBS, specify the original path and the alternate

location of the RBS store prefixed with -rbsStorSimple, enclosed within double
quotes, and separated by an equal sign. Each pair of path names (original
path=alternate location) must have its own -rbsStorSimple prefix and be separated
with a space.

s To automatically open the specified source database and view it in the source tree
view, type -a. (Does not apply if either RBS parameteris provided.)

4. Press Enter.

m [fthe "Show wizard on startup" boxis selected on the Data Wizard, Dell EMC
ltemPoint for Microsoft SharePoint Server opens the Data Wizard. The command
line content will appear on the Source Path Selection page.

m [fthe "Show wizard on startup" box s cleared on the Data Wizard, Dell EMC
ltemPoint for Microsoft SharePoint Server opens the Data Wizard at the Source Path
Selection page with the command line content displayed.

Note: In both cases, information entered from the command line appears on the
Source Path Selection page.

m [fthe -rbsfilestream prefixis used, the specified files will appearin the Remote Blob
Store Configuration dialog box during the source open process.

m [fthe -rbsStorSimple prefixis used, the specified path(s) will be changed and appear
in the Remote Blob Store Configuration dialog box during the source open process.

Note: For more information, see:

= "Remote Blob Store Configuration (FILESTREAM Provider)" on page 21
= "Remote Blob Store Configuration (Metalogix StoragePoint Provider)" on page 22

= "Remote Blob Store Configuration (StorSimple SharePoint Database Optimizer)” on page
23.

27



Opening Multiple Sources and Targets

You can display multiple sourcesin the Source pane and multiple targetsin the Target pane.
See the instructions for using the Data Wizard or the main window to open one source or one
target at atfime.

Source: CADocuments and Sethings | Target: hitp://1_target_server.local

= 5 Sources = [ Targets
oy ) i
= L %u-l S_Cumem_ﬁdﬂnczﬁ" ﬁ“. Target 2 - hitpe/#2_target_zerverlocal
+ = =8| =

= Source 2 - W55_Content_Ge2cab7z
8 Shared Services Administration: .
s Source 3-WSS_Contert_d0d025b:

Multiple Sources Multiple Targets

Figure 2-7: Multiple sources can be displayed

Opening ltems

You canview anitem's metadata from the source list, target list, search results, or the Previous
Versions window. You can then open the file directly from the metadata window if that file is
available (for example, itemsin a document library) and the native application of the file is
installed on your computer. Attachments can also be viewed with the native application of the
file.

You can also open afile directly from the main window without going through the metadata
window. Only one item can be opened from the list at a time.

Note: You can view the metadata of any type of item in the list. However, not every item can
be opened because of the type of item, the availability of the file itself (for example, itemsin a
document library), or the availability of the native application on your computer.

Note: Temporary files are created when file items are opened and then are cleaned out when
Dell EMC ItemPoint for Microsoft SharePoint Server is exited. However, any files still open in their
native application when you exit are not cleaned out. If this temporary location ever becomes
full, you will not be able to openitems.

To open an item's metadata

m Inthe Source orTarget list, right-click an item and select Open ltem, or highlight and
select Open ltem from the File menu. The item's metadata appears.
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Menu _|
Bar

Path /]

Itermn

Leaf Hame

Yersion No.

] &
5 WCF file - (ersion 200

e File  Tools

=)

| Path: Source 1- WS55_Content_22cb370295004f06a053400065141fb4a mdfShareFoint Ste’\Tabs'3_.000

Property Name Value
_ModerationComments

Attachments False
Comments Click for top sites
Content Type Tabs

Created By System Account

Created On

4/3072007 10:14:09 AM

m

File x0020 Type

Leaf Name 3 .000

Modified By System Account
Modified On 4/30/2007 10:14:09 AM
Page topsites.aspx
TabName Top Sites

Title

UlVersion 1.0

URL Tabs

Figure 2-8: Metadata for anitem

« The title of the window is the leaf name and the version number of the item.

« The pathto the file appears below the menu bar.

« Insource items, the File menu provides options to open or save attachments or

open the file.

« The Tools menu, available only in source files, provides the option to view any
previous versions of the file.

« Intargetitems, the menu bar provides options to open or save attachments, or

open the file.
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Opening the File

After viewing the item's metadata, you can open the file directly from the Open ltem
metadata window if the Open File optionis enabled. You can also open it from the main

window.

To open the file

m Do one of the following:

« Inthe Source orTarget list, right-click the item and select Open File, or highlight the
item and select Open File from the File menu.

« Inthe Openltem metadata window, select the File menu and select Open File.

Note: Files cannot be opened without the native application of the file being installed on
your computer.

Note: If the file is a ghost document and not the actual document in your site, it may not
be available to open.

Saving Attachments

A save attachments optionis available on the File menu and the Attachments submenu of an
openitem. The Save Attachments dialog box lists the atfachments for the selected item and
lets you select the attachments you want to save.

To save altachments in an openitem
1. Inthe listitem with a paperclip icon, do one of the following:
m On the File menu, select Save Attachments.
m Right-click the item and select Save Altachments in the context menu.

2. Inthe Save Attachments dialog box, select one or more attachments.
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Sawve Attachments @

Attachments:
TeshoCheckbow2007 Sub.xml

Save To

CAUzers\Documents - E]

Figure 2-9: Save Attachments dialog box
3. To Save To a different location, click Browse {...).
4. Inthe Browse For Folder window, select alocation for the attachment(s), and click OK.

5. Click OKin the Save Attachments dialog box.

Previous Versions in Source

You can open all previous versions of a source list item one at a fime. These list items can be
opened, copied, or exported, and the attachments can be saved.

To open previous versions of a list item
1. Do one of the following:
m Highlight the list item, select the Tools menu, and select Previous Versions.

= Highlight the list item, right-click and select Previous Versions.

2. Inthe Previous Versions window, open the item's metadata, open file, copy, or export any

item by using the menu orright-clicking the item. Save Attachments is enabled onitems

contfaining an atfachment.
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Previous Versions
File  Edit Tools
UlVersion 1] Leaf Name Title Content Type Modified On Created On Created B
1.0 category.aspx Site Dir...  Welcome Page 473072007 10:1... 473072007 10:1... System Acq
1042372007 12.... 4/30/2007 10:1...
11/30/2007 5:1... 4/30/2007 10:1... System Acc

cateqory.aspx Site Dir...  Welcome Page

CEtEfCICII')".ES"‘"" Cam Mii Udmlmrrme Dlmmm

Open Item Cirl+0
Open File
B Copy Cirl+C
B Export... Crl+p
1]

Figure 2-10: Previous versions of a source item
Note:

m See "Restoring Microsoft Office SharePoint Server Data" on page 48 for exporting
instructions.

m See "Saving Attachments" on page 41 for instructions on saving attachments.

m See "Restoring Microsoft Office SharePoint Server Data" on page 48 for copying
instructions.

m SharePoint only stores the attachments of the most recent version of anitem. If an
attachment of a previous version isremoved, it will not be shown in the Previous Versions
dialog.

Closing Sources and Targets

You can close sources and targets from the main window.

To close asource

1. Inthe Source pane, select asource content database file.

2. Do one of the following:
« Onthe File menu, select Close Store.
» Right-click the selection, and on the context menu, click Close Store.
o Press Cirl+L

To close all stores

m Do one of the following:

« Inthe Source or Target pane, right-click the root node, and click Close All Stores.
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« Onthe File menu, select Close All Stores.

To close atarget

1. Inthe Target pane, select target serverfile.
2. Do one of the following:
« Onthe File menu, select Close Store.
« Right-click the selection, and on the context menu, click Close Store

o Press Ctri+L
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Chapter 3: Searching on Microsoft
Office SharePoint Sources

Overview

The Find in Sources window enables you to search source content databases foritems that are
defined by such criteria as keywords, creators and modifiers, and item creation and
modification dates. In addition, this window lets you define the scope of your search: in one or
more content databases, sites, lists, folders, or even previous search results.

Guidelines for Using the Find Window

The following guidelines will assist you in your search and analyzing the results.

m Dell EMC ltemPoint can search multiple content databases at the same time. In the Find in
Sources window, click Browse and you will see a tree view of all of the open source data
stores. You can then select multiple sites or folders to include in your search.

= Previous versions of an item are not searched.
m Only asingle search window can be open at atime.
= The Find Now button only becomes available if at least one of the following conditions is
met:
« Nosearchisin progress.

« Allitems or a specific item type is selected in the Search foritem type OR Custom item
typesisselected and the custom item type box contains at least one character.

« The Search for words or Exclude words box contains at least one character.
« The Created by box contains at least one character.

« The Modified by box contains at least one character.

» The Created after or Created before check boxis selected.

« The Modified after or Modified before check boxis selected.

m Each Search in drop-down selection that you select isrun as a separate query, and the
results of the query are combined (thatis, OR'd together). For example, if you enter
"solution”in the Search for words box, and then select the Item Data and File Data option,
Dell EMC ltemPoint for Microsoft SharePoint Server will return items that contain "solution”in
either the item data or file data.
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= [fyou don't specify the Search for words or Exclude words, all items will be returned as hits
unless other criteria are provided.

Searching Sources

You can use the Find in Sources window to search single or multiple databases and perform
actions on the searchresults.

You can open, copy, export items, or save attachments on search results.

Opening the Find in Sources Window
In the source tree view pane, selecting the sources node, source node, site, list, or folder you

want to search enables the Find submenu and the Find icon ~ in the toolbar. The item(s) you
select defines the scope of your search.

To open the Find in Sources window

1. Select the item you want to search.

2. Do one of the following to open the Find in Sources window:

a Click Find pe) in the toolbar. The name of the folder you selected appears next to
the Search in box

m Right-click the folder and click Find

= Onthe Tools menu, select Find

= PressF3.

Note: The first time you search for an item, the Search in option is automatically selected.
Forinformation on using the Search in results option, see "Searching Within Results" on
page 40.
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Figure 3-1: The Find in Sources window

To search multiple sites, lists, or folders, click Browse (...) next fo the Searchin path. In the
Select Location(s) window, select the items you want to search.

i "

Select Location(s)

Source tree - 1 item(s) selected
ERWIER] Sources |
- #las 1- WS5_WSS_Content_6d5c25.
[]# default site Cancel
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=] Form Templates
[ ]« Personalization site links
[ ] Published links to Office clic
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s
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Search Subfolders

Figure 3-2: You can select multiple data stores to search.
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Note: If you select the Search Subfolders check box, Dell EMC ItemPoint for Microsoft
SharePoint Serverincludes subfolders in the search.

4. Click OKtoreturnto the Findin Sources window.
In the following illustration, the Search in box now displays "Multiple locations selected."

0.. Find in Sources E\@

File  Edit Tools  Help

@ Searchin: | <Multiple locations selected: B Find Mo l

Search for iterm type: [<.-’-‘«I||tems> v] [ Load Itern Types ]

Cugtom item tpes:

Search for words; | - Clear Fields

Exciude words: -

Search in: [Item Data b

Created by: -

Maodified by: -
[[] Created after. | 2/19/2015 [C] Created before; | 241972015

[C] Modified after: | 2/13/2015 [[] Modified before: | 2/19/2015

Mo Search Results &vailable

Figure 3-3: Result when multiple items are selected

Selecting the Item Type(s)

The Search foritem type drop-down list initially provides two options, All fems and Custom. The
entire list of possible item types can be lengthy. If you want to search all items or enterin your
own custom items, you can bypass this list. However, if you want to select item types from the
list, you can click the Load Item Types button and the entire list populates the Search foritem
type drop-down list.

To select the item types

= Inthe Search foritem type box, do one of the following:

« Allltems: Leave All ltems as the default if you want to search all items in the Microsoft
Office SharePoint Server source, OR
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« Custom: Select Custom in the drop-down list to manually enteritem typesin the
Custom item types box you want to be searched, separated by a comma, OR

« Load ltem Types button: If you have used the Load Item Types button, the list will
contain all of the item types present in the source databases. You can select the

specific type for which you are searching.

Note: If another source is searched and the Load Item Types button is clicked, those item
types are added to the drop-down list.

Narrowing the Scope of the Search

You can narrow down the scope of your search by entering keywords to search for and enter
any keywords that should be excluded. You can select what type of data to searchin: ltem
Data; Item Data and File Data; or ltem Data, File Data, and Attfachments.

To narrow the search down further, you can enter the person who created the item and/or the
person who modified it at some point. You also have the option of searching within a certain
range of dates.

To narrow search results

1. Inthe Search for words box, enter one or more words or phrases if you want to execute a
keyword search. Keep in mind the following points:

= Put aspace between words or phrases to perform an AND operation (that is, all
words must be matched in order to include an item with the search results).

m Put a comma between words or phrases to perform an OR operation (that is, only
one of the words must be matched in order to include anitem with the search
results).

m Put quotation marks around word phrases (that is, the exact phrase must be
matched in order fo include anitem with the search results).

Example:
Search forwords: dog cat mouse, rat

Searchresults: Items that contain ["dog" AND "cat" AND "mouse"] OR ["rat"] are
included in the search results.

2. Inthe Exclude words box, enter words or phrases if you want to perform a NOT operation.
If matched, these words or phrases will exclude the item from the search results. The rules
for using spaces, commas, and quotation marks apply when excluding words from a
search.

Example:
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3.

Search forwords: dog cat mouse, rat
Exclude words: bird

Searchresults: ltems that contain ['dog" AND "cat" AND "mouse”] OR ["rat"] BUT
NOT ["bird"] are included in the searchresults.

Inthe Search in box, select one of the following from the drop-down list: Item Data; ltem
Data and File Data; or Item Data, File Data, and Aitachments.

Note about searching within file data or attachments: Dell EMC [temPoint for
Microsoft SharePoint Server does not search within archive file types such as .zip or
rar files. For more information, see "Searching Within File Data or Attachments” on
page 42.

In the Created by and Modified by boxes, enter the appropriate names, if desired. The
rules for using spaces, commas, and quotation marks apply when using the Created by
and Modified by boxes.

For Created after and Created before or Modified before and Modified before, select the
appropriate check box, if desired. You may select both check boxes. Then type or select
the part of the date you want to change.

m Created after: Searches foritems created on or after the selected date.

= Created before: Searches foritems created on or before the selected date.
= Modified after: Searches foritems modified on or after the selected date.

= Modified before: Searches foritems modified on or before the selected date.

When you have finished specifying the search criteria, click Find Now. The results of your
search appearin the item list.
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Figure 3-4: Find in Sources window with results

Searching Within Results

The Searchinresults option lets you refine the search process using the previous search results.

To search within results

1. To make the Searchinresults option available, you must perform at least one search.

2. Modify the search criteria as desired. For information on specifying search criteria, see
"Searching Sources" on page 35.

3. Select the Search inresults option at the top left of the Find in Sources window.

4. Click Find Now. The results of your new search appearin the item list.

Using the Find Results

Using the Find results shortcut menu, you can:
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m Openanitem's metadata

m Open the file in the Search Results
m Copy and paste content

m Export anitem

= Save attachments

= View previous versions of anitem

Opening an Item's Metadata

You can open the metadata of anitem in the search results by right-clicking the item and
selecting Open ltem or selecting the item and selecting Open ltem from the File menu. Only
one item at atime can be opened from the list.

For more information, see "Opening Iltems" on page 28.

Opening the File in the Search Results

If the item is available (that is, items in a document library) and has an associated application
on your computer, the Open File optionis available in the context menu or the menu bar. If the
item does not have an associated application, (for example, contact, announcement,
calendar, and so on), the Open File optionis not available.

You can also open the file from the Open ltem metadata window. For more information, see
"Opening the File" on page 30.

Copying and Pasting Content

You can copy content from the search results list and paste them into a target. To copy and
paste the whole list, under the Edit menu, select Select All orright-click the list and select Select
All, then Copy.

For more information, see "Restoring Microsoft Office SharePoint Server Data" on page 48.

Exporting an Item

With the Export feature, you can copy individual or multiple items from the Find in Sources
window to alocal or network drive destination.

For more information, see "Exporting Microsoft Office SharePoint Server Data" on page 44.

Saving Attachments

You cansave any attachment of items that appearin the search results to the destination of
your choice.
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Previous Versions

By right-clicking a find result item, the context menu has Previous Versions enabled if that item
has previous versions associated with it. If Previous Versions is disabled, there are no previous
versions of that item. This optionis also available in the Tools menu.

Previous Versions

File  Edit Tools
UI\Version 1] Leaf Name Title Content Type Maodffied On Created On Cn
D D00 DO D DO D
20 1_.000 lssue #1  lssue 11/8/2007 9:26... 5/15/2007 11:0... Bot
30 0 1_.000 lssue #1  lssue 11/8/2007 2:.06... 5/15/2007 11:0... Bot
40 1] 1_.000 lesue H#1  lssue 11/8/2007 2:07... 5/15/2007 11:0... Bot

Figure 3-5: Previous versions of the item
When copying items, previous versions of the item are also copied.

For more information, see "Previous Versions in Source” on page 31.

Viewing Previous Search Results

You can click the Previous button multiple times to return to any previous search criteria and
searchresults. This button becomes unavailable when there are no more previous results.

To view previous search results

1. Perform at least two searches so the Previous button becomes available.
2. Click Previous. The results of the previous search appearin the item list.

3. You can now view the previous search, or you can modify the search criteria and
conduct a new search. Forinformation on specifying search criteria, see "Searching
Sources" on page 35.

Clearing Fields and Results

If you click the Clear Fields button, all of the search criteria that you entered in the Find in
Sources window are returned to the default settings. If you click the Clear Results button, all
current and past search results are cleared.

Searching Within File Data or Attachments

Inthe Find in Sources window, you can search the text of file data or attachments. The
searching within a file or attachments feature supports Unicode text and is available for MDF,
NDF, and LDF sources. Dell EMC ItemPoint for Microsoft SharePoint Server supports Microsoft®
Office documents and many other file types.
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Note about the licensing agent: The "Agent for Advanced Searching for SharePoint" must be
enabledin order to search file data or attachments.

To search within files and/or attachments

1. Inthe Find in Sources window, select Item Data and File Data or Item Data, File Data, and
Attachments from the Search in drop-down list.

2. Specify other desired search criteria. For more information, see "Searching Sources" on
page 35.

3. Click Find Now. If Dell EMC ItemPoint for Microsoft SharePoint Server matches a keyword
or phrase in the text of the file or attachment, it will return a "Hit" just as it would if it found a
keyword or phrase in the metadata of anitem.

Exceptions When Searching Within File Data or Attachments

Dell EMC ltemPoint for Microsoft SharePoint Server does not search for the following items:

= Archive files (for example, .zip, .rar)
= Binary files (forexample, .dll, .exe, .jpg)

» Metadata associated with files (for example, author and company informationin an .xls
file)

Restoring Items from the Find in Sources
Window

The results of conducting a search appearin the item list in the Find in Sources window. You can
restore the items in this list by dragging them or copying and pasting them into the target folder.

You can also restore items by browsing in the main window and dragging or copying and
pasting from the main window fo the target. You do not need to search to restore items. For
more information, see "Restoring Microsoft Office SharePoint Server Data" on page 48.
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Chapter 4: Exporting Microsoft Office
SharePoint Server Data

Overview

You can export data from a content source file to alocal or network drive destination.

Guidelines for Exporting Items

The following guidelines will assist you in exporting items.

m The file name for an exporteditem isits leaf name. A duplicate leaf name creates afile
with the same name but with an (x) appended to the filename: x = 1 for the first duplicate,
x =2 for the next duplicate, and so on.

m You must have accessrights to the target location of the exported item.
m Single or multiple items can be exported from the list view
m Single or multiple items can be exported from the tree view.

m Sub-items can be exported if the export isinitiated from the tree view. This includes sites,
lists, or folders underneath the selected tree node.

= You have the option to maintain the path to the item when the export isinitiated from the
list view. This creates a path including all the sites, lists, and folders up to and including the
item name.

m When exporting asite, list, or folder from the tree view, a file system folder will be created
based on the node name.

m Previous versions are exported to a subfolder named "document name" and"_Revisions"
(example: "Document_Revisions"). Previous version file names are "document name" and
"_Revision Number'(example: "Document_1.1").

m [fthe same item is exported twice to the same location, a numberis appended to the title
to give it a unique name. For example, if Sample File.doc is exported to c:\export path\
and another file with the same name already exists, it is exported as c:\export
path\Sampile File(1).doc.

Exporting List Items

The following instructions show you how to export alist item or multiple items from the Source
pane in the main window to a designated location. Iltems can be exported at asite, list, or folder
level.
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To export a listitem

1.

In the Source Message list, select the list item(s).

2. Do one of the following to start the Export Wizard:

s Onthe Tools menu, select Export.
s Onthe toolbar, click the Exporticon CY)
m Right-click the item, and on the shortcut menu, click Export.
m Enter Cirl+P.
In the Export To box, specify the location for the exported file.

To maintain the message path(s) of the exported list item(s), leave the default setting of
the selected Maintain item path check box. Clear the check boxif maintaining the
message pathis not desired.

Note: This option creates the path of all the sites, lists, and folders up to and including the
item name.

Choose the version to be exported from the following:
m Current version
= Previous versions
m All versions

Click Finish. The Export Progress window appears.

Note: Attachments of items cannot be exported. To retrieve attachments, use the Save
Attachments option.

To export a site

1.

In the Source pane, select the site.

2. Do one of the following to start the Export Wizard:

s OntheTools menu, select Export.

s Onthe toolbar, click the Exporticon CY)

m Right-click the site orlist, and on the shortcut menu, click Export.
m Enter Cirl+P.

Note: The topmost node of the Export Wizard is selected. If the site you are exporting
contains more than one level of child nodes and items, only the first level appears in this
list and can be exported.

Inthe Choose Export ltems pane, select the node(s) to be exported. The following options

are available:
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m Leave every check boxselected and export everything. Selecting the topmost
node check box automatically selects all child nodes.

m Clearthe child node check boxes using the Clear All button and export selected
items only.

m Select the Choose All button to select allitemsin the tree.

4. Leave the Export sub-nodes check boxselected if you want them exported as well or
clearit to exclude them.

Note: If the topmost node is selected under "Choose Export Itfems" and "Export
sub-nodes"is selected, all child nodes (and their sub-nodes) will be exported regardless of
their selection status

5. Click Next. The second page of the Export Wizard appears.
6. Select the Export To destination.
7. Choose the version to be exported from the following:

= Current version

m Previous versions

= All versions

8. Click Finish. The Export Progress report appears.

To export a list or folder

1. Inthe Source pane, select the list or folder.
2. Do one of the following to start the Export Wizard:
m Onthe Tools menu, select Export.
a Onthe toolbar, click the Exporticon .
m Right-click the item, and on the shortcut menu, click Export.

n Enter Chrl+P.

If the list or folder selected for export contains sub-items, the first page of the Export Wizard
appears.

If the list or folder selected does not contain any sub-items, the second page of the Export
Wizard appears.

3. Select the Export To destination.
4. Choose the version to be exported from the following:
m Current version

m Previous versions
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m All versions

5. Click Finish. The Export Progress report appears. This report can be printed or saved to your
local hard drive.
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Chapter 5: Restoring Microsoft Office
SharePoint Server Data

Overview

This section describes how to restore your content (items, lists, folders, and sites) fo alive
Microsoft Office SharePoint Server and provides guidelines and important notes for restoring
each type of data to its desired destination.

ltems can be restored from multiple locations: the free view list and folder, the source list, the
Previous Versions window, and the Find in Sources search results list.

General Guidelines for Restoring Microsoft Office
SharePoint Server Data

The following guidelines will assist you in restoring Microsoft Office SharePoint Server data. For
instructions to restore each type of data, see the following:

m "Restoring Iltems " on page 54
s "Restoring a Folder" on page 55
= "Restoring a List" on page 56

= "Restoring a Site” on page 57

General Guidelines

m [tems can be restored to lists or folders.

m Folders can be restored to lists or folders.

m Lists can be restored to sites.

m Sitescan be restored to sites or site collections.

m Site collections can be restored as new sites or site collections.

m Whenrestoring data to a domain other than the original domain, the author/editor
informationisinherited from the parent.

m Source data can be copied to a target running the same or newer version or experience
of Microsoft Office SharePoint Server.
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Before restoring documents with multiple versions, use the Library (or List) settings to
enable versioning on the target before restoring the documents if you want the version
history to be retained.

During any datarestore, the target location's parent site collection is checked for any
write locks that are selected. To restore data to any location within the site collection,
the "Adding content prevented," "Read-only," or "No access' must be cleared. These locks
can be set with the Microsoft Office SharePoint Server Central Administration
(Application Management > Site Collection Quotas and Locks).

To restore a folder to a list, set the "Make 'New Folder' command available" optionto Yes
in the Library (or List) Settings > Advanced settings for that list.

To restore the approval status of anitem or folder, set the Content Approval to Yesin the
Library (or List) Settings > Versioning setting for that list.

Record Routing lists have been deprecated from Microsoft Office SharePoint Server 2010
or later. When restoring a Records Center site that contains a Record Routing list to
Microsoft Office SharePoint Server 2010 or later, create Content Organizer Rules to
replicate the behavior of the Record Routing item:s.

Exceptions

The following are not restored during a copy:

o Alerts

o Checked out status of anitem

« Legal holdstatus of anitem
Blogs, comments, and posts may no longer be linked when restored as items.
Holds and Hold Reports lists are not displayed after restoring.

If the user does not exist in the target (for example, restoring across domains), the
author/editorinformationis inherited from the parent.

A FastSearchCenter site cannot be restored to a Microsoft Office SharePoint Server 2013
experience.

Managed metadata columns are not supported.

Microsoft Office SharePoint Server 2016 site collections can only be copied to Microsoft
Office SharePoint Server 2016 as a new site collection.

Only Microsoft Office SharePoint Server 2016 source data can be copied to a Microsoft
Office SharePoint Server 2016 target.
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Workflow Exceptions

m Started Workflows are not restored for anitem. This includes the history and associated
tasks for the Workflow.

m Workflows that are set up for a list are not restored. The history and task Lists are restored
but the associations are not automatically setup. Manual setup is possible.

SharePoint WebParts Exceptions

m ltemsthat contain WebParts, which point to other lists within the site, may not function
correctly if you cancel asite restoring operation before it completes.

m All WebParts are restored to the target, but they may not function properly after they
have beenrestored. Some WebParts store the path and IDs of lists and items they are
pointing fo. Since new IDs are generated and enable you to restore data anywhere, the
IDs and paths may no longer be valid after the WebPart is restored.

m IfaWebPart isrestored to same target location as the source, most WebParts will function
properly since the paths are the same.

Guidelines for Restoring to Recurring and Non-Recurring
Meeting Workspaces

The following guidelines will assist you in restoring Microsoft Office SharePoint Server data to
recurring and non-recurring meeting workspaces.

Guidelines

m Ifrestoring items to a non-series library list (for example, Document Library, Slide Library,
Picture Library, and so on):

« Only meetinginstance folders can be restored to the root of the list, and the instance
ID of the meeting instance folder being restored must match one of the instance IDs in
the target meeting workspace.

« No other folder oritem can be restored to the root of the list.

m Ifrestoring to a non-series list other than a library list (for example, Announcements, Tasks,
Contacts, and so on), the items being copied must match the meeting recurrence
criteria on the target.

m Ifrestoring to a non-series discussion board:

« Ifrestoring a discussion topic, the recurrence criteria of the topic must match the
target meeting recurrence criteria.
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« Ifrestoring a discussionitem, the item's recurrence criteria must match the recurrence
criteria of the discussion topic on the target.

m A farget list containing series items has the same constraints as any other list (for example,
content type match, checked out state, duplicate items, etc.).

m Whenrestoring alibrary list from arecurring meeting workspace into another site that is
not a meeting workspace, the same constraints apply (for example, content type match,
checked out state, duplicate items, efc.).

m Restoring alist from arecurring meeting workspace to a non-recurring meeting
workspace is not allowed unless the list is a series list.

m Restoring alist from a non-recurring meeting workspace to arecurring meeting
workspace is not allowed unless the list is a series list.

Dell EMC ItemPoint Agent for Content Transfer
Service

The Dell EMC ItemPoint Agent for Content Transfer Service (ACTS) must be running on the
Microsoft Office SharePoint Serverin order to restore content to a specific site. The Dell EMC
ltfemPoint Agent for Content Transfer Service can be started or stopped using the Services
management console or command line.

To start the Dell EMC ItemPoint Agent for Content Transfer Service with the Services management
console

1. Click Start, then select Run.

2. Inthe Run dialog box, type services.msc and click OK.

3. Inthe Services window, do one of the following:

» Double-click Dell EMC ItemPoint Agent for Content Transfer. On the General tab of the
Dell EMC ltemPoint Agent for Content Transfer dialog box, click Start.

» Right-click Dell EMC ItemPoint Agent for Content Transfer and select Start.
» Select Dell EMC ltemPoint Agent for Content Transfer and click Start in the left column.

« Select Dell EMC ltemPoint Agent for Content Transfer and click Start Service in the tool
bar.

4. Verify that the Dell EMC ltfemPoint Agent for Content Transfer service has started by
refreshing the Services window.
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To stop the Dell EMC ltemPoint Agent for Content Transfer Service with the Services management
console

1. Click Start, then select Run.
2. Inthe Run dialog box, type services.msc and click OK.
3. Inthe Services window, do one of the following:

» Double-click Dell EMC ItemPoint Agent for Content Transfer. On the General tab of the
Dell EMC ltemPoint Agent for Content Transfer dialog box, click Stop.

» Right-click Dell EMC ItemPoint Agent for Content Transfer and select Stop.
» Select Dell EMC ltemPoint Agent for Content Transfer and click Stop in the left column.

« Select Dell EMC ltemPoint Agent for Content Transfer and click Stop Service in the tool
bar.

4. Verify that the Dell EMC ltemPoint Agent for Content Transfer service has started by
refreshing the Services window.

To start the Dell EMC ItemPoint Agent for Content Transfer Service with the command line

1. Click Start, then select Run.
2. Inthe Run dialog box, type emd and click OK.

3. Inthe commandline, type net start "Dell EMC ItemPoint Agent for Content Transfer" and
press Enter.

4. Type net start fo view a list of services running and verify that the Dell EMC ItemPoint Agent
for Content Transfer service isincluded.

To stop the Dell EMC ItemPoint Agent for Content Transfer Service with the command line

1. Click Start, then select Run.
2. Inthe Run dialog box, type ecmd and click OK.

3. Inthe command line, type net stop "Dell EMC ltemPoint Agent for Content Transfer" and
press Enter.

4. Type netstart to view alist of services running and verify that the Dell EMC ItemPoint Agent
for Content Transfer service is absent.

Duplicate Checking

When copying and pasting Microsoft Office SharePoint Server data, two different types of
duplicate checking are performed:
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= Lists, Folders, and Document Library files: Duplicate checking checks the item's flename

or Leaf Name. If the target list contains an item that has the same name, you are

prompted with the option to overwrite.

m ltems: Iltems are flagged as duplicatesif they are copied from a source that is the backup

of the target and you are attempting to copy the item to the same location.

If alist is copied to another site with the same list, the contents of the source are added to the

target list. The properties of the source list does not overwrite the target list.

1] |_Leaf Mame |_Trt|e Cortent Type UIVersion Modified On Created On
Title_001ppte Title Slide 10 1/22/2008 10:4...  1/22/2008 10
Title_002 ppte Title Slide 10 17222008 1004, 172272008 10

L [ >

Figure 5-1: Leaf Name is used for checking duplicates in Lists, Folders, and Document Library files

If a duplicate is found, an overwrite confirmation message appears.

Feature Not Found

The Feature Not Found dialog box appears if a feature used by a source site is not found on the
target site; for example, when copying from a previous version of Microsoft Office SharePoint

Serverto a more recent version, the feature may longer be available.

If a feature is not found, your options are as follows:

If you want to: Click
this:
Continue copying the site without the missing feature and be alerted if other missing features are |Yes
detected during this copy session.
Continue copying the site without any missing features. Yes to
All
Skip the copying of the site and be alerted if another missing feature is found while copying No
another site during this copy session.
Skip the copying of all sites with missing features during this copy session. No to
All
LClose the Feature Not Found dialog box and end the copy session. Cancel )
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Overwrite Confirmation

The Duplicate Item dialog box appears if duplicate items are found during the copy/paste
process and the "Check for duplicates during copy" optionis selected on the Preferences
dialog box (Edit menu > Preferences command).

If a duplicate is found, your options are as follows:

If you want to: Click
this:

Overwrite the duplicate item. Overwriting the items causes the existing duplicate item to be Yes

deleted and the new item copied in its place.

Overwrite all duplicate items. Yes to
All

Rename the duplicate item. Rename

Rename all duplicate items. Rename
All

Avoid overwriting or renaming the duplicate item. Clicking Skip moves you to the next item and | Skip
ignores the overwrite message.

Avoid overwriting or renaming any duplicate items. Skip All

LClose the Duplicate Item dialog box and end the copy/paste process. Cancel )

Restoring Your Microsoft Office SharePoint
Server Data

This section provides examples of restoring sites, lists, folders, and items to the desired
destination. In each case, it provides guidelines forrestoring data. If you copy assite, list, folder,
oritem from the Source pane and paste it to any target destination, Dell EMC ItemPoint for
Microsoft SharePoint Server preserves the directory structure of all restored items. See specific
guidelines under each data type being restored.

Restoring ltems

The following instructions show you how to restore individual items to a folder in a target server.
To restore items
1. Inthe Source pane or Find in Sources window, copy the item from the item list.

2. Inthe Target pane, paste the itemsinto a folder orlist in the target server.

Note: You can also drag an item from the Source pane to the Target pane.
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3.

4.

In the Copy Progress window, verify that your items were successfully copied. You can
also print or save the copy report by doing one of the following.

= Click Print to print the copy report.
m Click Save fo save the copy report as a text file.

In the Copy Progress window, click Close to return to the main window.

Guidelines for Restoring ltems

You canrestore from the items list in the Source pane or the Find in Sources window.
Restoring individual items does not preserve the directory structure of the restored itemes.

"Pages’ item types may switch their content type whenrestored; however, metadata s
preserved. In this scenario, the content type becomes the default content type for the
list. Forexample, the content type on the source would be "Welcome Page," but after
restoring, the content type would be "Page."

Whenrestoring an item with moderation status (or approval status) of "Pending", the
author and editor are updated to "System Account."

When restoring items to Microsoft Office SharePoint Server 2010 and later, set the Content

Approval to No in the Library (or List) Settings > Versioning setting for that particular list to
avoid loss of version numbers and moderation status changes. Content Approval can be
set to Yes afterrestoring.

Restoring a Folder

The following instructions show you how to restore a folder to any target destination.

To restore a folder

1.
2.

Inthe Source pane, copy a folder.

Inthe Target pane, paste the folderinto a folder or list.

Note: You can also drag a folder from the Source pane to the Target pane.

In the Copy Progress window, verify your results to make sure youritems from all folders

were copied to the target destination. You can also print or save the copy report by
doing one of the following.

m Click Print to print the copy report.
m Click Save to save the copy report as a text file.

In the Copy Progress window, click Close to return to the main window.
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Guidelines for Restoring a Folder

m Folders may not have their created and/or modified date preserved whenrestored.

m The moderation status (or approval status) of a folderis not retained. The status of a folder
that has beenrestored is always "Approved."

Restoring a List

The following instructions show you how to restore a list fo any target destination.

To restore a list

1. Inthe Source pane, copy a list.
2. Inthe Target pane, paste the list info asite.
Note: You can also drag a list in the Source pane to the Target pane.
3. Inthe Copy Progress window, verify your results fo make sure that your lists were copied to

the target destination. You can also print or save the copy report by doing one of the
following.

= Click Print to print the copy report.
m Click Save fo save the copy report as a text file.

4. Inthe Copy Progress window, click Close to return to the main window.

Guidelines for Restoring a List

m Whenrestoring alist that contains alookup column that includes a field column that
references alist that does not exist on the target:
« For Microsoft Office SharePoint Server 2013, when browsing to the restored list, a "File
Not Found" error appears. To correct, manually remove the lookup field reference

columns from the restored list.

« For Microsoft Office SharePoint Server 2016, the lookup field reference column will be
empty.

Note: When creating or editing a Lookup column, you can include a field column by
selecting any of the "additional fields" columns associated with the lookup.

m Summary links columns do not function correctly after alist isrestored if the target does
not have the Workflows site collection feature activated. Attempting to edit any restored
items displays an XSLT error. To resolved the issue, enable the Workflows site collection
feature.

Note: Summary Links columns can only be added to Issue Tracking lists.
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m For Microsoft Office SharePoint Server 2013, restored lists may be added to asite's quick

links.

Restoring a Site

The following instructions show you how to restore asite to a target destination.

To restore a site

1. Inthe Source pane, copy asite.

2. Paste the site into the desired location of the Target pane.

Note: You can also drag asite in the Source pane to the Target pane.

. Ifthe source site is pasted into the root node of a target, the Select Site Collection URL
dialog box appears. Select the web application and site collection URL and enter the
primary site collection administrator information to copy the site by doing the following:

Select Site Collection URL

Select a'w'eb Application:
SharePoint - FOEF il

URL:  http:/fuzepx]dspoch04: 7067/
tanaged Path: Site Mame:

faites/ il

Frimary Site Callection Administrator
Authentication kode:

Farmz Authentication “

Primarny Site Collection Adminiztrato [uzemame];
adrin

Pazzword:

LCancel

Figure 5-2: Select Site Collection URL dialog box

a.

In the Select a Web Application drop-down list, select the web application to be used
as the target server.

In URL, view the web application URL label. This is the base URL where the new site

collection will be located

In the Managed Path drop-down list, select the managed paths that reside in the
target server for the selected Web Application. The contents of this list changes based
onthe Web Application selected. If you want to have a specific URL other than"/site/"
for asite collection, you need to select a managed path.
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o Ifyou select a managed path with Explicit Inclusion, a single Microsoft Office
SharePoint Server site can be created for the given URL, so nothing more is

required. If you select a managed path with Explicit Inclusion, the Site Name field

will be disabled.

Note: This option may not be available if a site has already been created for

the given path.

Example:http://servername:portnumber/Sales

o Ifyouselect a managed path with Wildcard Inclusion, you can create further site

collections under the specified managed path. The Site Name field is enabled

and you can create the site name which is appended on the path URL. In this case

you must specify a Site Name for the new site collection.

Example:http://servername:portnumber/Manufacturing/Group 1 and
http://servername:portnumber/Manufacturing/Group 2.

. Ifthe Site Name boxis enabled, enter a site name for additional welbsite addresses.

Note: The following characters cannot be usedin the site name: "# % & *:<>2\ /

{} ~. The site name also cannot start with an underscore character"_".

. Inthe Authentication Mode drop-down list, select Windows Authentication or Forms
Authentication.

. Inthe Primary Site Collection Administrator box, enter the following depending on the

mode of authentication you are using:

o If you are using Windows Authentication, enter the domain and username of the

user that will be the primary site collection administrator. This username must be in

the Domain\Username format. Dell EMC ItemPoint for Microsoft SharePoint Server

will use this username to connect to the new site collection afterit has been
created.

o If you are using Forms Authentication, enter the username of the user that will be

the primary site collection administrator. Dell EMC ItemPoint for Microsoft

SharePoint Server will use this username to connect to the new site collection after

it has been created.

. Inthe Password: box, enter the password for the primary site collection administrator.

The username and password are validated for the primary site collection
administrator, so the site collection will not be created until the correct password is
supplied for the site collection administration.

. Click OK. The source site is copied into the target site.
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4.

5.

In the Copy Progress window, verify your results to ensure that your sites were copied to
the target destination. You can also print or save the copy report by doing one of the
following.

m Click Print to print the copy report.
m Click Save to save the copy report as a text file.

In the Copy Progress window, click Close fo return to the main window.

Guidelines for Restoring a Site

Site Quotas for parent-level sites will not be restored.

Forsite and list permissions, if a matching group exists on the target, the site or list will use
the target group's permission levels and users associated with that group. If the target
group has different users or permissions levels than the source, the site or list will now use
the target's permissions .

Quick Links for sites that contain a Pages List (Publishing Site, Personalization Site, etc.)
may appear differently afterrestoring a site. Once a page type document (Page, Article
Page, Master Page, etc.) is checked into a pages site, a Quick Link is added. Since Dell
EMC ItemPoint for Microsoft SharePoint Server does not restore the checked out state,
items are assumed to be checked in. Therefore, additional Quick Links may appear after
the site has beenrestored.

When restoring assite collection from Microsoft Office SharePoint 2007 to Microsoft Office
SharePoint 2013 with the 2010 Experience, the following site collections are blocked:

Enterprise
» Records Center
« Site Directory
o Report Center
« Search Center with Tabs
« My Site Host
Publishing
« Collaboration Portal

« Publishing Portal

When restoring a site with unique master page from Microsoft Office SharePoint 2007 to
Microsoft Office SharePoint 2013 with the 2010 Experience, the default look and feel is
applied. To restore the original master page look and feel, add the master page to the
Master Page Gallery list and change the master page in Site Settings.
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Note: The master page should be prepared for Microsoft Office SharePoint Server 2013.
Also, all files referenced in the master page file must exist on the target.

m Restoringsites to a Microsoft Office SharePoint Server 2013 or later farget may produce
duplicate "Site Contents'linksin the site's "Current Navigation" pane.

About the Copy Progress Window
Each time you attempt to restore items to the Target pane, the Copy Progress window appears.
This window displays the following information about the copy operation:

m Source, Source Path, Target, and Target Path

m Time of copy operation

» Number of items, lists, folders, and sites

m  Warnings and errors, if any

» Number of items successfully copied

Copy Progress

Total number of tems to be processed: 1

[

All tems successfully copied.

Copy finished on 6/5/2008 at 3:25:24 PM.
£ I

Copy Finizhed

[

|

Time Remaining: 00h:00m:00=

| o—— ———

Figure 5-3: Copy Progress Window

Note: If you do not have full access rights to the target location, Dell EMC ItemPoint for Microsoft
SharePoint Serveris unable to complete the copy process. The target location must also have
enough space for the data and it must support the content type of the source data.

Print Copy Progress Data as a Report

When the copy progress is complete, you have the option to print the report which records any
interruptions in the copy progress or any errors that occurred. This report lists the number of:
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m items that successfully copied
m items that did not copy

m errors that occurred

To save the Copy Progress report as a text file to the destination of your choice, click Save.

Configuring the Dell EMC ItemPoint Agent for
Content Transfer Service to Validate Forms
Authentication Users

Whenrestoring a top levelssite (site collection), Dell EMC ItemPoint for Microsoft SharePoint
Server validates the primary site collection administrator before restoring the site collection. If
the primary site collection administrator is using Forms Based Authentication (FBA), the Dell EMC
lfemPoint Agent for Content Transfer Service (ACTS) must be configured for the FBA provider
used by the restored site collection. The FBA provideris determined by the web application
hosting the restored site collection. The web applicationis selected in the Create Site
Collection URL dialog box. For more information, see "Restoring a Site" on page 57.

If the primary site collection administrator using Claims Based Authentication, the Dell EMC
lfemPoint ACTS must be configured for the Claims authentication provider used by the restored
site collection.

To configure the Dell EMC ltemPoint ACTS to validate site collection users for Forms Based
Authentication (SharePoint 2007 and later)
1. Determine the FBA provider for your web application by doing the following:
a. Open SharePoint Central Administration for your target Microsoft Office SharePoint
server.
o For Microsoft Office SharePoint Server 2007, do the following:

a. Click the Application Management tab, then in the Application Security
group, click Authentication providers.

b. Onthe Authentication Providers page, click the Web Application and then
click Change Web Application.

c. Inthe Select Web Application dialog box, select the web application you
want o use to restore your site collection. The selected application appearsin
the Authentication Providers page. The FBA provider name appearsin the
Membership Provider Name column. This is the FBA provider.
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o For Microsoft Office SharePoint Server 2010 and later, do the following:
a. Onthe Cenfral Administration, click Application Management.
b. Under Web Applications, click Manage web applications.

c. Onthe Web Applications tab, select your web application from the list and
click Authentication Providers on the toolbar.

d. Onthe Authentication Providers dialog box, in the Zone column, click the zone
you are using.
e. Onthe Edit Authentication dialog box, scroll down to the selected Enable
Forms Based Authentication (FBA) boxin the Claims Authentication Types row.
Below is the ASP.NET Membaership provider name box containing the FBA
provider.
b. Copy the FBA provider name and use it in the following steps:
2. Locate the FBA provider configuration section for the web application by doing the
following:

The configuration section for the FBA provider may be located in the web.config for the
web application, orit may be inherited from the machine.config.

« The web.configislocatedin the lIS virfual directory for the web application (typically
at C:\inetpub\wwwroot\wss\VirtualDirectory\<port number of web application>\).
« The machine.configislocatedin: [WINDOWS Directory]
\Microsoft. NET\Framework\<version>\CONFIG\.

In the appropriate config file, locate the <membership> section under <system.web>.
Under this section, find the <providers> section and locate the provider that matches the
FBA provider name for your web application. It should appear similar to this:

<add name="AspNetSglMembershipProvider"
type="System.Web.Security.SglMembershipProvider, System.Web,
Version=2.0.0.0, Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a"
connectionStringName="LocalSglServer" applicationName="/" />

This line must be copiedinto the ACTS configuration file, as described in the next step.

3. Addthe FBA provider and connection string to the ACTS configuration file by doing the
following:
Edit the PC.SharePoint.Service.exe.config file, located in the ACTS install folder.

a
b. Inthe configfile, add the <system.web> sectionifit's not already there.

O

Within the <system.web>, add the <membership> section.

o

Within the <membership> section, add the <providers> section.
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e. Paste the Forms providerinto the <providers> section. The modified config file
should appear similar to the following:

<configuration>
<system.web>
<membership>
<providers>
<add name="aspnetmembershipprovider"
connectionStringName="MySQLServer"
applicationName="MyAppNametype="System.Web.Security.SglMembe
rshipProvider, System.Web, Version=2.0.0.0, Culture=neutral,
PublicKeyToken=b03f5f7f11d50a3a" />
</providers>
</membership>
</system.web>
. other sections..
</configuration>
For Microsoft Office SharePoint 2010 and later, you also need to copy the "i" provider
sectioninto the PC.SharePoint.Service.exe.config fle and make it the default provider.

This provider goes within the same <providers> section as the FBA provider. To make it

the default provider, add the defaultProvider="i" attribute to the <membership> section
as shown below.

Note: If you are using multiple membership providers, each membership
provider must have a unique name. Also, make sure the "i" provider only
appears once in the <providers>section of the

PC.SharePoint.Service.exe.config file.

<membership defaultProvider="i">
<providers>
<add name="i"

type="Microsoft.SharePoint.Administration.Claims.SPClaimsAuthMe

mbershipProvider .. />
<add name="AspNetSglMembershipProvider" connection
StringName="MySQLServer" .. />
</providers>
</membership>

4. Copy the Connection String configuration section by doing the following:

The connection string used by the FBA provider also needs to be copied from the
web.config (or machine.config) into the PC.SharePoint.Service.exe.config file.

You can find the connection string by looking at the <connectionStrings> section of the
web.config (or machine.config) file and finding the connection string whose name
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matches the connectionStringName attribute of the FBA provider. In the example above,
the connection string name is "MySQLServer", so you would locate the "MySQLServer"
connection string and copy that into the PC.SharePoint.Service.exe.config file as
described below.

a. Addthe <connectionStrings> section to the PC.SharePoint.Service.exe.config file in
the <configuration> section.

b. Inside the <connectionStrings> section, add the connection string line from the
web.config (or machine.config). When you are finished, the modified
PC.SharePoint.Service.exe.config should look similar to the following:

<configuration>
<connectionStrings>
<add name="MySQLServer" connectionString="Initial
Catalog=aspnetdb claim;datasource=USEPX1DSQOCBO1\OCBO1A;
Integrated Security=SSPI;" />
</connectionStrings>
<system.web>
<membership>
. membership providers ..
</membership>
</system.web>
. other sections..
</configuration>

5. Save all changes to the PC.SharePoint.Service.exe.config file.

After the ACTS configuration file has been modified, the Dell EMC ItemPoint Agent for
Content Transfer Service must be restarted before the changes will take effect.

To configure the Dell EMC ItemPoint ACTS to validate site collection users for Claims Based
Authentication (SharePoint 2010 and later)

1. Locate the Claims based provider configuration section for the web application by doing
the following:

The configuration section for the Claims provider may be located in the web.config for
the web application, orit may be inherited from the machine.config

« The web.configislocatedin the IIS virtual directory for the web application (typically
at C:\inetpub\wwwroof\wss\VirtualDirectory\<port number of web application>\).
« The machine.configislocatedin: [WINDOWS Directory]
\Microsoft. NET\Framework\<version>\CONFG\.

In the appropriate config file, locate the <membership> section under <system.web>.

Under this section, find the <providers> section and locate the provider with the name "i".
It should appear similar to this:
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<add name="i"
type="Microsoft.SharePoint.Administration.Claims.SPClaimsAuthMembe
rshipProvider, Microsoft.SharePoint, Version=15.0.0.0,
Culture=neutral, PublicKeyToken=71e9bcellle9429c" />

This line must be copiedinto the ACTS configuration file, as described in the next step.

Add the "i" provider to the ACTS configuration file by doing the following:

a
o}
c
d

@

Edit the PC.SharePoint.Service.exe.config file, located in the ACTS install folder.

In the config file, add the <system.web> sectionifit's not already there.

. Withinthe <system.web>, add the <membership> section.

. Within the <membership> section, add the <providers> section.

Paste the "i" providerinto the <providers> section.

Set the "" provider to be the default provider by adding the defaultProvider="i"
attribute to the <membership> section.

When you have completed these changes, the modified config file should appear
similar to the following:

<configuration>
<system.web>
<membership>
<providers>
<add name="i"
type="Microsoft.SharePoint.Administration.Claims.SPClaimsAut
hMembershipProvider, Microsoft.SharePoint, Version=15.0.0.0,
Culture=neutral, PublicKeyToken=71e9bcellle9429c"™ />
</providers>
</membership>
</system.web>
. other sections..
</configuration>

3. Save all changes to the PC.SharePoint.Service.exe.config file.

After the ACTS configuration file has been modified, the Dell EMC ItemPoint Agent for
Content Transfer Service must be restarted before the changes will fake effect.

To restart the Dell EMC ItemPoint Agent for Content Transfer Service

A LD

. Click Start, then click Control Panel.

On the Control Panel windows, click Administrative Tools.

On the Administrative Tools window, click Services.

On the Services window, right-click Dell EMC ItemPoint Agent for Content Transfer and

click Restart.

65



Glossary

Term Description

Data Store

A unified collection of folders, items, and lists contained in a single
storage medium.

Data Wizard

The first time you start Dell EMC ltemPoint for Microsoft SharePoint
Server, the Data Wizard appears. The Data Wizard guides you
through the loading of MDF, NDF, and LDF files into Dell EMC
ItemPoint for Microsoft SharePoint Server, and shows you how to
specify the target Microsoft Office SharePoint Server.

Document
Library

A folder where a collection of files is stored and the files often use the
same template.

Duplicate
Checking

A process detecting duplicate items based on filenames which
provides you the option to overwrite the item.

Experience
Level

Often referred to as the "Compatibility Level" or "SharePoint mode,"
this indicates the settings for how Microsoft Office SharePoint Server
presents and interacts with features and content.

Explicit
Inclusions

Selected in Managed Paths, explicit inclusions include only the
specific path that you set. For example, use explicit inclusions if you
want Microsoft Office SharePoint Server to manage a specific path,
such as /portal, but not any possible sites below it, such as
/portal/teamshare.

GUID

Globally Unique Identifier. Each Microsoft Office SharePoint Server
database has a separate GUID.

Item

An entry in alist or folder (posts, pictures, links, comments, etc.)
contained within a list or a folder in the Source or Target panes.

List

A website component that stores and displays information that users
can add to, copy, and search in Dell EMC ItemPoint for Microsoft
SharePoint Server.

Log Files

Transaction log files (.Idf files) are history files recording server
activity. These files are useful in restoring and backing up Microsoft
Office SharePoint Server data.

Managed Paths

With Managed Paths, you can manage two categories of paths:
included and excluded paths when creating a top-level website ora
specific URL. Anincluded path indicates that it is a Microsoft Office
SharePoint Server-created path. An excluded path indicates that a
different application manages the path and was created by the user.
Included paths can be further broken down into the following two
types: Explicit Inclusions and Wildcard Inclusion.

66



Term Description

MDF, NDF, and |Microsoft Office SharePoint Server content database files used as the

LDF Files source. The three files work as a collection to comprise a single
content database. You must have one MDF, one or more LDF, and
optionally zero or more NDF files.

Metadata Data about data. For example, the title, subject, author, and size of a

file constitute metadata about the file.

Non-series List

A non-series list is a special list created for meeting workspaces and
have specific instances of the meeting assigned to the list.

Previous Items, such as documents and pictures, create a backup copy

Versions whenever it is saved to the library in Microsoft Office SharePoint
Server. These previous versions are accessible in Dell EMC
ItemPoint for Microsoft SharePoint Server.

Series List A series list provides a way to have a regular list in a recurring meeting

workspace. A series list shows all of the items for all occurrences of a
meeting.

Shortcut Menu

This menu is accessed by right-clicking on an item.

Site

A group of related web pages that generally cover one or more lists
and folders.

Site Collection

A set of websites that have the same owner and share administration
settings. Each site collection contains a top-level website and can
contain one or more subsites.

Source

The Microsoft Office SharePoint Server content database stored on a
Microsoft Office SharePoint Server from which folders and lists are
copied. The source is read-only, so items cannot be copied into,
deleted from, or changed in the source.

Target

The data store to which lists, folders, and items are restored.

Wildcard
Inclusion

Selected in Managed Paths, wildcard inclusion includes any sites
below the path that you set, so you do not have to add them
individually. This is the type of inclusion to use for specific site names
that are appended to the URL, when you want to be able to create top-

level websites underneath a specific path, such as /sites. )
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opening in main window 25
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